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The NA-MIC Kit




3D Slicer version 4 (Slicer4.4)

An end-user application for
image analysis

An open-source environment
for software development

A software platform that is
both easy to use for clinical
researchers and easy to
extend for programmers




Slicer Modules

« Command Line Interface (CLI):
standalone executable with limited input/
output arguments

» Scripted Modules (Python):
recommended for fast prototyping

 Loadable Modules (C++ Plugins):
optimized for heaving computation



Slicer4 Highlights: Python

The Python console of Slicer4 gives access to
scene objects (MRML)
data arrays (volumes, models)
GUI elements that can be encapsulated in a
module

Processing Libraries: numpy, VTK, ITK,CTK



Slicer4 Scripted Modules

Python scripted modules allow more
interactive functionalities (e.g. ‘Flythrough’
in Endoscopy module) and rapid prototyping

GUI based on Qt libraries accessed via Python

@ python’



Tutorial Goal

This tutorial guides you through the steps of
programming a HelloPython scripted module
for running a Laplacian filtering and sharpening.

For additional details and pointers, visit the

Slicer Documentation page

http://wiki.slicer.org/slicerWiki/index.php/Documentation/
Nightly




Processing Examples in this Tutorial

Manipulation
with numpy

Image Data on
Disk (DICOM,
Nifti, nrrd...)

Manipulation
< with VTK

MRML Scene I
\__ ,

Manipulation

MRML: Medical Reality Markup Language, with ITK
the Slicer Data Representation (Slicer CLI)



Prerequisites

This course supposes that you have taken
the tutorial: ‘Slicer4 Data Loading and
Visualization’- Sonia Pujol Ph.D.

The tutorial and HelloPython dataset are
available on the Slicer4.4 compendium:

http://www.slicer.org/slicerWiki/index.php/Documentation/Nightly/Training

Programming experience is required, and
some familiarity with Python is essential.



Course Material

Slicer4.4 version available at www.slicer.org

| "
spgr.nhdr HelloPython.py

spgr.raw.gz HelloLaplace.py
(124 SPGR images) HelloSharpen.py

Unzip the HelloPythonSlicer4.zip archive



Course Overview
Part A: Exploring Slicer via Python

Part B: Integration of the HelloPython.py
program into Slicerd

Part C: Implementation of the Laplace
operator in the HelloPython module

Part D: Image Sharpening using the Laplace
operator



@ python’

Part A: EXPLORING SLICER VIA
PYTHON



Python in Slicer

Slicer 4.4 includes python 2.7.3 and a rich set of

standard libraries
Included.:
> numpy, VTK, CTK, PythonQt,
and most of standard python library

Not included:

> scipy (scientific tools for python),

> matplotlib (python 2D ploting library),

> ipython (interactive python)

and some other popular packages that we have
found difficult to package for distribution



Python Console in Slicer

fdit m Help

o) me to Slicer — ‘ L \) O @ o %
LJ Cxtension \mnager url+4 -
® S: 0.000mm 156

Ctrl+5

~ Module Panel
Toolbars

@ 3@ Layout
v

Velc: Select View > Python Interactor, or
e ClICK the button @

G Download Sample Data ‘

>

»

‘ w Customize Slicer

¥ Feedback -

(defzult, Nov

Share your stories with us and let us know about how 3D
4 2014, 0€:35:52)

Slicer has enabled your research. Python 2.7.3

(AMDE4)] on win32

We are always interested in improving 3D Slicer, and every submission will be >>>

See more at http://goo.gl/6BvcHm.

carefully read.

> About

¥ Data Probe

Slice Annotations:




General Python Console Features

Command Line Editing:
~ Left/Right Arrow Keys, Home, End
> Delete (Control-D)

Command Completlon
> Tab Key -

Input History:
~  Up/Down Arrow Keys




Add Volume

-
m Edit View Help

= AddData ctrl+0

L1253 picom

Download Sample Data

&a save Ctrl+s
Recently Loaded 4

78 Close Scene Ctrl+w
Exit

vveTrcol

S J
EWM ; Load DICOM Data

4#: Customize Slicer

¥ Feedback

- Share your stories with ¢

We are always interested in improving 3D Sl
Seem

> About
» The Main Window

» Loadina and Savina
¥ Data Probe

Slice Annotations: | «®

1. Select File > Add Data

5O 3&‘

S: 0.000mm 1

- 2. Select Choose File(s) to add

.| Add data into the scene

Choose Directory to Ad | |Choose File(s) to Add

Show Options

File name: spar.nhdr

Files of type: | All Files (*)

=8 sparraw.gz

v Description
%] Open ? X
Look in: elloPythonSlicer4\helloPython\data Q [E] @
R Fan

3. Load the dataset spgr.nhdr
located in the directory
| A=) HelloPython/data

A: 0.000mm




Add Volume

‘.Choose Directory to Add | ‘.Choose File(s) to Add | Show Options
v File Description I:I
¥ C:J/Users/Fan/Desktop/HelloPythonSlicer4/helloPython/data/spar.nhdr Volume =

4. Select Volume for the Description

| | | Reset .




Access to MRML and Arrays

_ —— Run the following code in
the Python console

Pythen 2.7.3 (default, Nov
(AMDE4)] on win32

>>> a = slicer.util.array('spgr')
>>> print(aﬂ

4 2014, 0€:38:52) [MSC g

a = slicer.util.array('spgr’)

- Uses the slicer.util package to
return a numpy array of the image
—>The variable 'a' is a numpy ndarray
of the volume data we just loaded

print( a)

—>Shows a shortened view of the array




Access to MRML and Arrays

= - [ S = 3
File Edit ]
A
& @ Slicer Python Interactor @@M
LMOL V.15UU ©4 P1T (AMUR4) ] ON Wlnse ’:‘
>>> a = slicer.util.array('spgr') ]
>>> print(a)
[[000 ..., 00 0] 1l
m (000 ..., 000]
’ (011 ..., 351]
102 ..., 112]
[s20 ..., 41 4]
\ (411 ..., 414]]
‘ [[00O0 ..., 00 0]
[00O0 , 00 0]
Y [2 1 , 512]
323 , 01 3]
= 012 , 12 3]
|l (012 ...,12 211
‘ ¥ Feedback i rroo -, 000l
‘ 000 , 00 0]
[3z1 , 41 3]
‘ (323 ..., 231]
(012 ..., 111]
[l (012 ..., 111]]
We are alway .
carefully read (000 ..., 00 0]
(000 ..., 000]
131 ..., 022]
> About .
30 ..., 02 3]
11 ..., 01 3]
b The Main W 11 ..., 01 3]]
¥ Data Probe
[(000 ..., 00 0]
(000 , 00 0]
Slice Annota! (131 ...,222]
113 ...,121]
(673 , 2 358]
L [5e3 ..., 23 4]]
F [(000 ..., 00 0]
B 000 ..., 00 0]
z10 , 10 0]
(zz1...,12z2]
C—— (040 ..., 013]
[030 ..., 012111
>>> =

The intensity values of the épgr

Image appear in the Python

console

R: 3.050mm

A: 14.238mm




Access to MRML and Arrays

File Edit View Help

ol

# Slicer Python Interactor
(000 ..., 00 0]
(131 ..., 222]
(113 ..., 121]
(6 73 ..., 23 5]

|l (563 ..., 23 4]]

l ttooo ..., 00 0]
(000 ..., 00 0]
(210 ..., 10 0]

|l 221 ...,12 2]
(040 ..., 01 3]

jl 030 ..., 01211

>>> print(a.min(), a.max())

" Slicer has enabled your research.

Iways interested in improving 3D Slicer, and every submission will be

We are al
carefully read.

See more at http://goo.

» About

P The Main Window
¥ Data Probe

Slice Annotations: | “#

al/6BvcHm.

. Type the following command to
display the min and max
“intensity value of the spgr image
R~ |

print( a.min(), a.max() )

—>Use numpy array methods
to analyze the data




Access to MRML and Arrays

Imin=0;Imax=355

= . ] B =& L 3 B 5 -
File E
o | # Slicer Python Interactor
c—- - = sy ===
(113 ..., 12 1]
(.D [ 73 ..., 2 3 5]
= (563 ..., 2 3 4]]
Ml [(f(ooo ..., 00 0]
(000 ..., 00 0]
l z210...,100
oy (221 ..., 12 2]
(040 ..., 01 3]
9' [030 ..., 012111
>>> print{a.min(), a.max())

'Feedbl (0' 355)
>>>

_ Share your stories with us and let us know about how 3D
Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every submission will be
carefully read.

See more at http://goo.qgl/6BvcHm.
> About

P The Main Window
¥ Data Probe

Slice Annotations: |

R: 3.050mm G| A: 14.238mm




4| v

Manipulating Arrays

* Run the following code in the Python console, - -

def toggle():
n = slicer.util.getNode('spgr')
a = slicer.util.array('spgr')
al:] = a.max()/2. - a
n.GetlmageData().Modified()
print("Toggled')

>>>
>>> def toggle():
n = slicer.util._getNode('spgr')
a = slicer.util.array('spgr')
al:] = a.max()/2. - a
n.GetImageData () .Modified()
print('Teggled')

>>> toggle()
Toggled
>>>

toggle()

8 'r‘__". A "
. ALY

For practice: use up arrow and return

keys to execute toggle() over and over -




The toggle function in more detail

def toggle():
> Defines a python function
> Body of function performs element-wise math on
entire volume
> Easy mix of scalar and volume math

Telling slicer that the image data for node 'n’
has been modified causes the slice view
windows to refresh



Qt GUI in Python
 Run the following code inthe ~ m ‘- @« « - O
Python console

-—

a\
\

=
i |, 0‘ Slicer Python Interactor @@g

b = qt.QPushButton('Toggle’) & ||\ )
b.connect('clicked()', toggle) N | 2 Qqeaste”

print('Toggled')

ToggYed
r1 i | >>> b = gt.QPushButton('Teggle') —
t).S; ()\A/() >>> b.connect('clicked()', toggle)
True

>>> b.show(ﬂ

P About

‘ P The Main Window
| ¥ Data Probe

What do you think will happen when you run this code?
What about when you push the button?

| —



Original Result

(*) Put the slicer view windows front to see the changes



In More Detail

Slicer uses PythonQt to expose the Qt library

Sophisticated interactive modules can be
written entirely with Python code calling C++

code that is wrapped in Python

> e.g. Endoscopy, Editor, SampleData, ChangeTracker,
and other slicer modules in the Slicer source code

(*) Qt: http://gt-project.org/
(**) PythonQt: http://pythongt.sourceforge.net/ (MeVis)




‘ﬁ‘ 3DSlicer

4

¥ Help & Acknowledgement

Help | Acknowledgement

Example of scripted loadable extension for the HelloPython tutorial.

r \

B Siicerp..| %

"6" Hello World!

¥ A collapsible button @ OK

Hello world

PART B: INTEGRATION OF THE
HELLOPYTHON TUTORIALTO
SLICER4



HelloPvthon.py

Open the file HelloPython.py
Located in the directory

HelloPython.py - C:\Users\Fan\Des elloPythonSlicer4\helloPython\code\HelloPython.py
e Editan Formata Runm OpticnsmsWintdowsms Help

_main__

vtk, qt, ctk, slicer

helloPyth

on\code

Module
Description

Module GU

Processing
Code

-

W

HelloPython:

_ init_ (self, parent)
parent.title = ": o
parent.categories
parent.dependencies = []
parent.contributors = ["

HelloPythonWidget:
__init__ (self, parent = None):

parent:
self.parent = slicer.gMRMLWidget ()
self.parent.setLayout (qt.QVBoxLayout ())
self.parent.setMRMLScene (slicer.mrmlScene)

self.parent = parent
self.layout = self.parent.layout ()
parent:
self.setup()
self.parent.show()

setup (self):
nstantiate and co;

apsible button
sampleCollapsibleButton = ctk.ctkCollapsibleButton ()
sampleCollapsibleButton.text = col e

self.layout.addWidget (sampleCollapsibleButton

# Layout with he sample collapsible button
sampleFormLayout = gt.QFormLayout (sampleCollapsibleButton)
1d butto
Section

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as
self.helloWorldButton

stance attri
helloWorldButton

onHelloWorldButtonClicked (self) :
t o o

stname

Lastname

(ozg) "

=)

Ln: 69|Col: 11




Module Description

class HelloPython:
def _init__ (self, parent): <— constructor

parent.title = "Hello Python"

parent.categories = ["Examples"]

parent.dependencies = []

parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware)",
"Steve Pieper (Isomics)",
"Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"

parent.helpText = """

This code is Example of scripted loadable extension for the HelloPython tutorial.

provided in
the template

parent.acknowledgementText =

This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through
the NIH Roadmap for Medical Research, Grant U54 EB005149."" # replace with organization,
grant and thanks.

self.parent = parent



Module GUI

# HelloWorld button

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print ‘Hello world' in standard ouput.”
sampleFormLayout.addWidget(helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)




Processing Code

qt.QMessageBox.information(
slicer.util.mainWindow(),
'Slicer Python', 'Hello World!')




Integrating HelloPython

e Q=:0dl View Help

IENCATE SO E 11> \Wdlcome to Slicer
LS Fal™
A
[-J Copy Ctrl+C
[] paste Ctrl+v
&Y 35S Ticer

4

Welcome

»

v

A Settings

1. Select Modules from the
Edit > Application Settmgs

Load DICOM Data I

& Customize Slicer ‘ ‘

¥ Feedback

General

Appearance
Views

Extensions
Cache

Developer
Python
Extension Wizard
Units

Volume rendering

«2. Open the side

»~ panel and click Add

b TheM

¥ Data Probe

Slice Annotations: | < ®

Skip loading of any: loadable modules command-line plugins scripted loadable module

Skip loading of builtin: loadable modules command-line plugins scripted loadable module
Prefer Executable CLIs:
Show hidden modules:

Temporary directory: |  C:/Users/Fan/AppData/Local/Temp/Slicer
Additional module paths: Paths ]
Add
<<
Remove
lules: =l
AddManyMarkupsFiducialTest
v * Add Scalar Volumes »
v ﬁ Annotations
v * AtlasTests
V| P RRATNS Strin Rotation b
Default startup module: ‘ £\ Welcome to Slicer v

Favorite Modules: @ 0 i Z.
Drag & drop from Modules list

Transforms Markups Editor »

Volumes Models

Reset Restore Defaults JOK x Cancel 10¢em




Integrating HelloPython

)
# | Select folder = 25 =]

@Qv| » HelloPythonSlicerd » helloPython » code v‘*’y” Search code
Organy

ev New folder
i Name Date modified Type
3 Libraries

<| Documents

/ .\ Music

3. Add the path to the directory
containing HelloPython.py
(when selecting the directory,
the HelloWorld.py file itself

will not be displayed)

Select Folder y [ Cancel

I




Integrating HelloPython

File Edit View Help

& 0
Modules:

N\ Welcome to Slicer

All Modules

Z) Annotations
Slicer A\ Data

DataStore
& picom
Welco~ =
Markups
€ Models
[Gistsy Load DICOM Da| @ Scene Views
Subject Hierarchy
4> Customize Slicer 4 Transforms
H View Controllers
¥ Feedback @ \Volume Rendering
@ Volumes

Velcome to Slicer

- Share your stories w
Wizards
Informatics
We are always interested in improving 3{ Registration
See Segmentation
Quantification
Diffusion
IGT
Filtering

> About

» The Main Window

Surface Models

B 1 Azdina 3nd Cavina

Converters
¥ Data Probe

Endoscopy

Utilities
Slice Annotations: | <® Developer Tools
Legacy

Jastiag

4

- VO & /B t-18 w5 +- @7
| |
| 4. Restart Slicer when prompted.

- F1€lI0 Python is now in the
| Modules Menu, under the
= Category Examples

carefully read.

"o

L BRAINS

:

Unspecified

»

RV TP - U R S p S |

Multivolume Support

Hello Python Part D - Sharpen




@ 3DSlicer
-4

4

HelloPython in Slicer

File Edit View Help

Modules:

Hello Python

-
v

Slicer

5
g

¥ Help & Acknowledgement

".g Click on Help and

Acknowledgment

Help Acknowledgement

This file was originally developed by Jean-Christophe Fillion-Robin, Kitware
Inc., Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's
Hospital and was partially funded by NIH grant 3P41RR013218-1251 (NAC)
and is part of the National Alliance for Medical Image Computing (NA-MIC),
funded by the National Institutes of Health through the NIH Roadmap for
Medical Research, Grant US4 EB005143.

Contributors: Jean-Christophe |
and Sonia Pujol (BWH)

n-Robin (Kitware), Steve Pieper (Isomics)

In the Hello Python module

@ Slicer P... :.:

¥ A collapsible button

‘ o Hello World!

Hello world

m
R: 0.000mm [=9G 'S¢

Expand

¥ Data Probe

Slice Annotations: | «®

and click on the Hello World button

the A Collapsible button tab,




3DSlicer

Part C:
Implementing the
Laplace™ Operator

*named after Pierre-Simon, Marquis de Laplace (1749-1827)

S.Pujol, Ph.D. - S.Pieper, Ph.D.
NA-MIC ARR 2012-2014



Overview

The goal of this section is to build an image
analysis module that implements a Laplacian

filter on volume data

Use gMRML widgets: widgets
that automatically track the
state of the Slicer MRML scene

Use VTK filters to manipulate
volume data




HelloLaplace.py

File Edit Format Run Options Windows Help

from _ main ort vtk, gqt, ctk, slicer =
#
# Hellolaplace
#
a HelloLaplace: |
__init__ (self, parent):
parent tltle = "Hell

parent.categories
parent.dependencies =
parent.contributors =

"Firstname Lastname (Org)"
parent.r

parent.

#

F

#

lass HelloLaplaceWidget:
ef _ init__ (self, parent = None):
]
Opel | the file HeIIoLapIace.py
| ted in the di t helloPython\cod
# Col
self.laplaceCollapsibleButton = ctk.ctkCollapsibleButton()
self.laplaceCollapsibleButton.text = "L e
self.layout.addWidget (self. laplaceCo1lap31ble3utcoﬂ)
ll # Layout within the laplace collapsible button

self.laplaceFormLayout = gt.QFormLayout (self.laplaceCollapsibleButton)

# the volume selectors

self.inputFrame = gt.QFrame (self.laplaceCollapsibleButton)
self.inputFrame.setLayout (qt.QHBoxLayout ())
self.laplaceFormLayout.addWidget (self. 1npthrame)

AAIE S e Calamtan = e AT Alal (W Trme Alimme W mATE SemieTwamal




This code is
provided in
the template

Module GUI (Part 1)

def setup(self):

# Collapsible button

self.laplaceCollapsibleButton = ctk.ctkCollapsibleButton()
self.laplaceCollapsibleButton.text = "Laplace Operator"
self.layout.addWidget(self.laplaceCollapsibleButton)

# Layout within the laplace collapsible button
self.laplaceFormLayout = qt. QFormLayout(self.laplaceCollapsibleButton)

# the volume selectors

self.inputFrame = qt.QFrame(self.laplaceCollapsibleButton)
self.inputFrame.setLayout(qt.QHBoxLayout())
self.laplaceFormLayout.addWidget(self.inputFrame)
self.inputSelector = qt.QLabel("Input Volume: ", self.inputFrame)
self.inputFrame.layout().addWidget(self.inputSelector)
self.inputSelector = slicer.gMRMLNodeComboBox(self.inputFrame)
self.inputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), ")
self.inputSelector.addEnabled = False
self.inputSelector.removeEnabled = False
self.inputSelector.setMRMLScene( slicer.mrmIScene )
self.inputFrame.layout().addWidget(self.inputSelector)



This code is
provided in
the template

Module GUI (Part 2)

self.outputFrame = gt.QFrame(self.laplaceCollapsibleButton)
self.outputFrame.setLayout(qt. QHBoxLayout())
self.laplaceFormLayout.addWidget(self.outputFrame)
self.outputSelector = qt.QLabel("Output Volume: ", self.outputFrame)
self.outputFrame.layout().addWidget(self.outputSelector)
self.outputSelector = slicer.gMRMLNodeComboBox(self.outputFrame)
self.outputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), " )
self.outputSelector.setMRMLScene( slicer.mrmIScene )
self.outputFrame.layout().addWidget(self.outputSelector)

# Apply button

laplaceButton = qt.QPushButton("Apply Laplace")
laplaceButton.toolTip = "Run the Laplace Operator."
self.laplaceFormLayout.addWidget(laplaceButton)
laplaceButton.connect('clicked(bool)', self.onApply)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.laplaceButton = laplaceButton



In More Detail

CTK is a Qt Add-On Library with many useful
widgets, particularly for visualization and medical
imaging see http://commontk.org

Qt Widgets, Layouts, and Options are well
documented at http://qt-project.org

gMRMLNodeComboBox is a powerful slicer widget
that monitors the scene and allows you to select/
create nodes of specified types (example: here we
use Volumes = vtkMRMLScalarVolumeNode)



& Processing Code

_ laplacian = vtk.vtkimageLaplacian()

Add this laplacian.SetlnputData (inputVolume.GetlmageData())
code laplacian.SetDimensionality(3)

laplacian.Update()




In More Detail

vtkimagelaplacian is a vtkimageAlgorithm operates
on vtkimageData (see http://vtk.org)

vtkMRMLScalarVolumeNode is a Slicer MRML class

that contains vtkimageData, plus orientation

information ijkToRAS matrix (see http://www.slicer.
org/slicerWiki/index.php/Coordinate systems)




In More Detail (Continued)

Global slicer package gives python access to:
> GUI (via slicer.app)
> modules (via slicer.modules)
> data (via slicer.mrmiScene)

slicer.app.applicationLogic() provides helper
utilities for manipulating Slicer state



s 1, H
) Welcome to Slicer

All Modules

/J Annotations
A\ Data
DataStore
&2 picom
Pl /. Editor
Markups
€ Models

Ka Scene Views

Subject Hierarchy

s Transforms
H View Controllers

@ \Volume Rendering

@ Volumes
&N Welcome to Slicer
W
x Wizards
Informatics
¢ Registration
Segmentation
p Quantification
Diffusion
IGT
Filtering
Surface Models
Converters
Endoscopy
Utilities
Developer Tools
Legacy
Testing
BRAINS

Unspecified

MultiVolume Support

Go To Laplace Module

= Q0 Q9 O
' @® R

3D

* |be

Hello Python

L relopython PartC -Laplace |

Hello Python Part D - Sharpen

Restart Slicer and select module.
Note that combobox is empty.

¥ Help & Acknowledgement

Help Acknowledgement

This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc., Steve Pieper,
Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was partially funded by NIH
grant 3P41RR013218-1251 (NAC) and is part of the National Alliance for Medical Image Computing
(NA-MIC), funded by the National Institutes of Health through the NIH Roadmap for Medical
Research, Grant U54 EB005149.

Contributors: Jean-Christophe Fillon-Robin (Kitware), Steve Pieper (Isomics) and Sonia Pujo!
(BWH)

¥ Laplace Operator

4

Input Volume: | Select a Volume

4

Qutput Volume: | Select a Volume

Apply Laplace



Add spgr.nhdr

»  Modules: Hello Python Part C -Laplace & | ™ Q @ u » E t v » v E »

1
o

¥ Help & Acknowledgement

3DSlicer

Help Acknowledgement

“
Isomics, Inc., and Sonia Pujol, Brighan

grant 3P41RR013218-1251 (NAC) and
(NA-MIC), funded by the National Ins{ Choose Directory to Add ||Choose File(s) to Add Show Options

Research, Grant US4 EB005149.

v File Description

Contributors: Jean-Christophe

(BWH)

¥ C:/Users/Fan/Desktop/HelloPythonSlicer4/helloPython/data/spar.nhdr

4

Volume

¥ Laplace Operator

Input Volume: | Select a Volume

Output Volume: | Select a Volume

Load the dataset spgr.nhdr »
located in the directory
HelloPython/data

¥ Data Probe

l- Reset

Slice Annotations: | ®




After Adding Volume

¥ Laplace Operator

1. Note that Input Volume combobox
autoselected new volume

Input Volume: |spgr

|
B e 2. Create new volume for output
o :

Output Volume: spgr

Output Volume: | Volume =

Apply Laplace %

‘S‘z,’éfi‘ét"""“ei 3. Run the module




Laplace Module

_ Result of Laplace Operator
ta thla e [Aeemcme s = - @ © ON SPr Volume

| 3DSlicer

» Help & Acknowledgement J

¥ Laplace Operator J

Input Volume: [spgr s ‘
Output Volume: [Volume s ‘
| Apply Laplace ‘

Run the Laplace
Operator.

B: Vollmi=

ST
-y e p. 3 050mm

¥ Data Probe

|| vy
Slice Annotations: I @

@ o

Baollimnte § B: Vollmie
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narpening with
olace Operator




Overview

The goal of this section is to add a
processing option for image sharpening.

We’'ll implement this
operation using the existing
Slicer Command Line
Module

‘Subtract Scalar Volumes’




HelloSharpen.py

% HelloSharpen.py - CAUsers\Fan\Desktop\HelloP

File Edit Format Run Options Windows Help

| from _ main  import vtk, gt, ctk, slicer
F
# HelloSharpen
I #
HelloSharpen:
_ init__ (self, parent):
parent.title = "Hell

parent.categories =
parent.dependencies =
parent.contributors =

Org)"
parent.helpText = """

Example of scri loadable

waw

wan

parent.acknowledgementText
vy de

NIH Roadmap for

self.parent = parent

with organization, grant and thanks.

FS
# qHelloPythonWidget |
#
class HelloSharpenWidget:
= F init (aal f narant = Nonea) -

Open the file HelloSharpen.py
located in the directory helloPython\code

ef setup(self):

# Collapsible button

self.laplaceCollapsibleButton = ctk.ctkCollapsibleButton()
self.laplaceCollapsibleButton.text = "Sharpen COperator"
self.layout.addWidget (self.laplaceCollapsibleButton)

# Layout within the laplace collapsible button
self.laplaceFormLayout = gt.QFormLayout (self.laplaceCollapsibleButton)

3

# the volume selectors




Add to Module GUI

Add this self.sharpen = qt.QCheckBox("Sharpen", self.laplaceCollapsibleButton)
Text in self.sharpen.toolTip = "When checked, subtract laplacian from input volume"
) self.sharpen.checked = True

section A self.laplaceFormLayout.addWidget(self.sharpen)




&=+ Add to Processing Code

Add this #optionally subtract laplacian from original image

) if self.sharpen.checked:

TeXt,'n parameters = {}

section B parameters['inputVolume1'] = inputVolume.GetID()
parameters['inputVolume2'] = outputVolume.GetlD()
parameters['outputVolume'] = outputVolume.GetlD()
slicer.cli.run( slicer.modules.subtractscalarvolumes, None,

parameters, wait_for _completion=True )




In More Detail

slicer.cli gives access to Command Line
Interface (CLI) modules

CLI modules allow packaging of arbitrary C++
code (often ITK-based) into slicer with
automatically generated GUI and python
wrapping



Go To Sharpen Module

&) Welcome to Slicer = ) » @ (58
All Modules '

£ Annotations

A\ Data

- DataStore

& picom

/. Editor
Markups

€ Models

K. Scene Views

Restart Slicer and select module.
Note the new sharpen check box

Data
Subject Hierarchy 1

&= Transforms {'ple Data
E View Controllers

0 Volume Rendering
@ Volumes

&Y Welcome to Slicer

ug icer has enabled
‘\Al'izards » UPUL vaiannic. STITLL O vyuiainnc
Informatics ¥

D Registration » arefully read. v Sharpen

tl Segmentation L4 Aool
Quantification vk When checked, | s
Diffusion vl subtract laplacian
16T v L from input volume
Filtering )
Surface Models ' E
Converters i =
Endoscopy 1
Utilities 4 5
Developer Tools 4
Legacy ’
Testing ’
BRAINS ’

& velopybon

Unspecified 4

¢ Hello Python Part C - Laplace

L » -
MultiVolume Support * Bython Part D - SF



Add spgr.nhdr

th harpen
Add d. 0 the scene
hoose 20 Add |Ohoose Fle(s) to Add
v
v q o 00 Helk Vok e

Load the dataset spgr.nhdr
located in the directory

HelloPython/data

| e




After Adding Volume

¥ Laplace Operator

1. Note that Input Volume combobox
autoselected new volume

Input Volume: | spgr

Output Volume: = spgr '
JE=SE 2. Create new volume for output
E ____________ T — I

3. Run the module

¥ Sharpen

Apply N
E Run the Laplace or
: Sharpen Operator.




Sharpen Module

Result of Laplacian

@ @ Modules: - ‘ ok Hello Python Part D - Sharpen 3] - e » ‘ @ % .4

' ° 2+ Sharpening Operator on
_spgr volume

/775N
¥ Help & Acknowledgement ‘ L :

Help I Adh led it |
Example of scripted loadable extension for the HelloSharpen tutorial.

¥ Sharpen Operator ]

Input Volume: [spgr = ]
Output Volume: [Volume s ]
v Sharpen

Apply ]

¥ Data Probe

Sice Annotations: | {®

BAVSInTe § B: Vollmnie




Sharpen Module

Adjust Window/Level with

@ Modules: ok Hello Python Part D - Sharpen 5 | ™ » % (48] » Eﬁ'

o » T Left-Mouse-Drag in Slice

» & 4r v Axal < | Volume
v

@ 3DSlicer

> Help & Acknowledgement
¥ Sharpen Operator
Input Volume: | spar

Output Volume: | Volume

¥ Sharpen

Apply

B: Volume

¥ Data Probe

Slice Annotations: | «®

8 : Vol s g e 3 B: Volume




Image Sharpening

Laplacian filtered

Laplacian

original




Going Further

Explore numpy for numerical array
manipulation

Review Endoscopy Module for interactive
data exploration using MRML and VTK

See the Editor Module for interactive
segmentation examples

Explore SimplelTK for image processing
using ITK



Conclusion

This course demonstrated how to
program custom behavior in Slicer
with Python

g @ python’

3DSlicer
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